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1 Overview

Who can benefit from reading this document?
This document provides information on using the HP Mosaic Dynamic Personalization application within the HP 
SmartStream Designer product. HP Mosaic is designed for HP SmartStream Designer users that want to include 
variable images in jobs. Basic HP SmartStream Designer knowledge is required.

This version of HP Mosaic is included in the following HP SmartStream Designer software versions:

● HP SmartStream Designer 14.1 for Adobe InDesign CC2019, Mac or PC

● HP SmartStream Designer 23.2 for Adobe Illustrator CC2019, Mac or PC

Introduction
HP Mosaic is a Dynamic Personalization option for HP SmartStream Designer. The application is a random image 
generator. It creates unique PDF files based on a template file (.txt) and one or more original vector PDF files. The 
vector PDF files should have square dimensions (equal height and width).

The application takes a vector PDF file as input (also known as a Seed file), and then generates a large number of 
variations on the file by transforming it — scaling, transposition, and rotation — randomly. The output are used 
as variable image assets in the graphic design of VDP jobs.

An HP Mosaic job includes a Seed Set, which is a group of one or more Seed files. The Mosaic image files that are 
output are created from these Seed files.

Figure 1-1  Example of one-vector PDF source file (Seed file) and 5 HP Mosaic varied output

Provided the PDF source file is sufficiently complex, each variation created by the application is unique. The cover 
of this guide features a project created with HP Mosaic.
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The output HP SmartStream Designer file can be a PDF or an HPD template file. HPD Template files can be 
submitted to the following:

● HP SmartStream Composer Server

● HP SmartStream Composer-L&P

● HP Production Pro Indigo Commercial DFE

● HP Production Pro Indigo for Labels and Packaging DFE

● HP PrintOS Composer

The HPD file can be created as HPD Rich or HPD Fast. See Creating an output file or HPD template file 
on page 33. HPD Rich is supported only with HP SmartStream Composer Server and HP PrintOS Composer.
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2 Getting started with the Sample job

The following steps are the recommended first steps to use HP Mosaic.

● Using the default Seed files embedded in Designer:

1. Create a new document in InDesign/Illustrator and define an Image Frame.

2. In the Designer Data Field panel, select Counter. Accept the default (1-10 records).

3. Select the Image Frame. In the Data Field panel, click the HP Mosaic icon.

The Image Frame is now defined as an HP Mosaic Personalization channel.

This channel uses the 3 Seed files embedded in the Designer application: Diamonds, Explosions, Melting.

– You can click OK and Save and use Preview to view the HP Mosaic variations.

– You can Edit to change the default settings.

– You can also Edit to change the Seed files from the default ones to your own graphic design, if you 
have any.

For details of editing, see Using HP Mosaic editing options on page 9.

● Using a predefined Sample job:

1. Download HP Mosaic 2.0 Sample Job.zip or HP Mosaic 3.0 Sample Job.zip. These ZIP file are available 
in Designer page, Designer Online contents.

2. From the SmartStream Designer menu select “Designer Online” in the window that opens click 
“Download SmartStream Designer” button. The Designer page then opens. Select the required tab: 
InDesign or Illustrator and scroll down to “Dynamic Personalization” header. Download the HP Mosaic 
sample file.

3. To open the file using SmartStream Designer, rename the HPD file to ZIP: File.hpd to File.zip
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4. Unzip the and view folder contents. It contains a sample Adobe InDesign or Illustrator file, related 
files, and PDF source files for the HP Mosaic application (Seed files). The figure illustrates the file 
structure.

Figure 2-1  HP Mosaic 2.0 Sample Job.zip file structure

Figure 2-2  HP Mosaic 3.0 Sample Job.zip file structure
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3 Workflow

Workflow steps
1. Open an InDesign or Illustrator document.

2. Using the HP SmartStream Designer menu, select a database file that includes at least 1 field with numeric 
data (whole numbers larger than zero, typically counters such as 1,2,3,...), and then define an Image 
Channel.

Alternatively, you can select the Counter button from the Data Fields panel, to create and select a database 
file that contains a numeric field with a numeric data.

3. Draw a frame box:

● In Illustrator, use the Rectangle Tool 

● In InDesign, use the Rectangle Frame Tool 

4. From the Channels panel, click on the Image Channel button.

Selecting HP Mosaic from the Dynamic Image applications list

Double-click the channel row in the Channels panel to open the Image Channel window.
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Figure 3-1  Image Channel window

1. Select Dynamic Image from the Type dropdown list.

2. Select HP Mosaic from the Application dropdown list.

Note that PDF is the only available format.

3. For the Images Path, select the path where the Seed files are located. Uncheck the Use Default checkbox if 
required and select the correct path.
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4. Click Settings. The Dynamic Personalization Settings window opens.

The Demo_template_file is selected by default.

Select a database field that contains numeric data (positive whole numbers). Each number generates a 
unique HP Mosaic image.

Figure 3-2  Dynamic Personalization Settings window in Designer for InDesign

Figure 3-3  Dynamic Personalization Settings window in Designer for Illustrator
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5. If the workflow does not use additional editing options, click OK to close the Settings window and then the 
Image Channel window. Without the editing option, the job uses the Seed files that are related to the 
supplied sample job. To replace the Seed file with your own graphic design, see Using HP Mosaic editing 
options on page 9.

6. Select the HP SmartStream Designer Preview panel to enable preview of the results.

Using the HP Mosaic button to create an HP Mosaic Image Channel

Another, shorter way to create an HP Mosaic Image Channel, is to use the HP Mosaic button in the Data Fields 
panel.

1. In a new InDesign or Illustrator file, use the SmartStream designer data Fields panel to define a database 
file. Alternatively, you can select the Counter button from the Data Fields panel, to create and select a 
database file that contains a numeric field with a numeric data.

2. Draw a frame box:

● In Illustrator, use the Rectangle Tool 

● In InDesign, use the Rectangle Frame Tool 

3. While the frame box is selected, click the HP Mosaic button from the Data Fields panel.

Clicking this icon automatically does the following:

● The Image frame is now defined as an Image channel.

● Its type is changed to Dynamic Personalization, HP Mosaic channel.

● The Settings window is opened.

4. If the workflow does not use additional editing options, click OK to close the Settings window. Without the 
editing option, the job uses the Seed files that are supplied with the Designer application. To replace the 
Seed file with your own graphic design, see Using HP Mosaic editing options on page 9.

5. Select the HP SmartStream Designer Preview panel to enable preview of the results.

HP Mosaic Image Channel indication

● HP SmartStream Designer for Adobe Illustrator: The HP VDP logo displays in the center of the channel.

● HP SmartStream Designer for Adobe InDesign: The channel indicator now includes the following 
information.

– The HP Mosaic Template name

– An orange gear icon that indicates Dynamic Personalization
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Figure 3-4  HP Mosaic Image Channel for Illustrator (1) and InDesign (2)

Using HP Mosaic editing options
It is possible to edit the HP Mosaic parameters with the HP Mosaic Template Editor. The changes are saved in the 
HP Mosaic Template file (txt) that is associated with the job.

The following parameters can be edited:

● Add another Seed Set or duplicate an existing Seed Set and edit its content.

● Add, replace, or delete Seed files

● Edit the parameters of a Seed file.

● Optional: If the Seed file contains spot colors, shuffle the Seed file’s spot colors or replace them with other 
colors.

Follow these steps to open the HP Mosaic Template Editor:

1. For a Dynamic Personalization Image Channel with HP Mosaic definitions, open the Image Channel window 
which is already defined as a Dynamic Image/HP Mosaic channel.

In the Dynamic Personalization Settings window for a new job, the Demo_template_file is selected by 
default.

The Demo_template_file is locked and cannot be edited. To edit the file:

● In InDesign, click Save As Template to save a copy of the original template file.

● In Illustrator, click Duplicate to save a copy of the original template file.
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2. In the Dynamic Personalization Settings window, click Edit.

The HP Mosaic Template Editor window opens.

Figure 3-5  HP Mosaic Template Editor - Main window

Editing the HP Mosaic settings

The main HP Mosaic Template Editor window enables you to edit the HP Mosaic Channel parameters.

The window is divided into three panes, the Template, the Sets, and the Seeds panes.

Template pane

In the HP Mosaic, the default template contains 1 Seed Set which contains 3 individual Seed files, Diamonds.pdf, 
Melting.pdf, and Explosions.pdf.

In the Template pane, the location of the Seed files that will be part of the HP Mosaic channel are selected.
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Figure 3-6  HP Mosaic Template Editor - the Template Pane

1 Template Name Displays the HP Mosaic Template name. Here you can type a new name for the template.

2 Seeds Folder Displays the path for the Seed files. By default, the Seeds Folder displays the path for the default 
three default seeds unless a database file with a different Default Assets Folder was selected.

Note: The names of the Seed Files may appear in red if the path to Seed Files was changed.

3 Browse Click Browse and select Seed File to appear in the HP Mosaic channel. Multiple files can be selected. 
Alternatively, drag and drop the file(s) into the Browse area.

Sets pane

A Seed Set is a group of one or more Seed files.

In the Sets pane, the definitions for the Seed Set are defined. Here you can add or delete Seed Sets and define 
the records range for each Seed set.

Figure 3-7  HP Mosaic Template Editor - the Sets Pane

1 Set Number Displays the current Seeds Set number. When editing a Seed Set, pay attention that the required 
Seed Set number is displayed.

2 Description Provide a brief description of the Seed Set for reference.

3 Range Define the first and the last database record value for this Seed Set. Displays maximum range for the 
number of combinations that can be created from the defined Seed Set. The range should 
accommodate the database numbers. For example, a range of 1-100,000 can accommodate 
database/counter numbers of 1, 2, 3,…99,000, 100,000, but not 100,001 or higher. See Defining the 
Range values on page 12.

4 Previous Set/ Next 
Set

If multiple Seed Sets are defined for a given template, use this function to display the next or the 
previous Seed Set.

5 Duplicate Set Use this function to create a new Seeds Set. This function duplicates the selected Seeds Set. You will 
then need to edit the settings for the new Seed Set.

6 Delete Set If multiple Seed Sets are defined for a given template, use this function to remove one or more 
Seeds Set if required.
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Defining the Range values

For any Seed Set, the Seed files and Range must be defined. The Range is the range of database record values 
for which the defined Seed files will be used to create Mosaic images.

This is relevant if the Mosaic database column content is a counter (1,2,3….) and not a random numeric data 
such as ID numbers, membership numbers, etc. that are not sequential.

Example 1

If the database field contains non-counter numbers (such as ID numbers) and a number is within the range of 
1-299,999 (such as 123,456), then the HP Mosaic variation that is created for it is generated using the Seed files 
of Set 1.

Example 2

Two Seed Sets could be defined for a given template as follows:

If the database file that contains the numeric data for the HP Mosaic channel is a simple counter (1,2,3,…
400,000), then:

● Set 1:

– Range: 1–299,999
– Seed files: Diamonds, Explosions, Melting

● Set 2:

– Range: 300,000–399,999
– Seed files: Bluish flowers, Bluish shapes

Note that the Range index of any added Seed Set starts with the value +1 of where the previous Seed Set ends.

Seeds pane

In the Seeds pane, the definition for the HP Mosaic variations are defined.

Figure 3-8  HP Mosaic Template Editor – The Seeds Pane
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1 Seed tabs The Seed tabs display the Seed files that are part of the HP Mosaic channel. Select a tab and then 
edit the parameters for every Seed file as required.

2 Seed File Select a Seed file from the Seed File dropdown list. Any Seed file that is available at the designated 
Seed Path is available to select. Take note of the recommendations in Seed file design 
recommendations on page 23.

3 Scaling Set the Minimum Scale and Maximum Scale values for the HP Mosaic image output. The default 
values range from 200% to 500% enlargement. Note that special attention is needed for Scaling 
parameters when the minimum scaling is less than 142% and Rotation option is selected. For more 
information, see Selecting the Scaling and Rotation options for a Seed file on page 14.

4 Position Select the Random radio button for the application to randomly select a different area/portion of the 
Seed file for every variation. Select the Centered radio button to create the variations where the 
center of the Mosaic variation is always the center of the Seed file. The default value is Random.

5 Rotation Use the Rotation options to set the rotation of the Seed file: None: No rotation. Free Rotation: Any 
angle rotation is allowed to produce Mosaic variations.

Every [X degrees]: Specify the step angle to use for each, e.g. Every 45°, by selecting a value from 
the drop-down list. For more information, see Selecting the Scaling and Rotation options for a Seed 
file on page 14.

6 Crop according to 
channel proportions

This option overrides the 3 Fitting options in the Image Channel window and is set per Seed, not to 
entire channel and all of its Seeds.

Use this option to utilize the Seed file, e.g. Mosaic variations are generated out of the maximum area 
of the Seed files, including the near edges.

7 Shuffle Spot Colors The Shuffle Colors option is available for Seed files that are defined with Spot colors. Use this 
function to shuffle between the Seed File’s spot colors or to shuffle the Seed File’s spot colors with a 
new set of spot colors. For more information, see Shuffle Spot Colors on page 16.

8 Seed Preview Preview of the Seed file displays here. The red and blue squared frames show the smallest and the 
largest Mosaic variation portion (depending in the Scaling parameters) compare to the Seed file, 
taking into account the parameters defined for the HP Mosaic channel.

If rotation is on, make sure the square frame is inside the Seed file portion and not cut off.

9 Apply Settings To All 
Seeds

Use this function to apply the same settings defined for one Seed File to all the other Seed Files 
within the Seed Set. For more information, see Apply Settings to All Seeds option on page 16.

10 Previous/Next Seed If multiple Seed Files are defined for a given Seed Set, use this function to preview and set the 
parameters for the next or previous Seed File. Note that when clicking on the Next or Previous 
buttons, the Seed’s tab, Seed File name, Seed Preview and parameters display.

11 Duplicate Seed Use this function when you want to add a new Seed File to the Seed Set. Duplicate the Seed File with 
the most appropriate parameters for the New Seed File. This option copies all the defined settings so 
the only required update is the Seed Name. Select the Seed name from the drop-down list and then 
change any other parameter if required.

12 Delete Seed If multiple Seed Files are defined for a given Seed Set, use this function to delete a Seed file if 
necessary.

13 All Seeds Use this function to display the Seed file names defines in the Seed Set. Selecting one of the Seed 
Files displays the selected Seed parameters.
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Example of HP Mosaic output variations

In the following example, a single Seed file is used, Rotation is None, Minimum/Maximum Scale is 100% and 
1000%. The difference between the HP Mosaic variations of the upper row and the lower row are the Position 
option settings.

Figure 3-9  Seed file

Figure 3-10  Position: Centered

Figure 3-11  Position: Random

Selecting the Scaling and Rotation options for a Seed file

Special attention is needed for Scaling parameters when selected together with the Rotation option.

The minimum value for scaling is 100% and the maximum value for scaling is 1000% - 10 times of the original 
Seed file. However, when selecting one of the Rotation options, plus a minimum value for scaling smaller than 
142%, blank area may appear instead of actual Seed file contents.

To avoid that, if Rotation option is on, then you need to increase the minimum scaling to 142% or above.
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If an HP Mosaic channel is set with No Rotation, then there is no restriction to select the minimum Scaling value 
100%.

Figure 3-12  Example

1 Mosaic Channel frame 3 Mosaic Channel

Scaling 100% — any %

Free Rotation %

2 Mosaic Channel

Scaling 100% — any %

No Rotation %

4 Mosaic Channel

Scaling 142% — any %

Free Rotation %

If an HP Mosaic channel is set with No Rotation, then there is no restriction to select the minimum Scaling value 
100%.

Note that when selecting Scaling value less than 142% together with the Rotation option, a Yellow triangle 
indication appears. Hover over the yellow indication to show the recommended Scaling value.

Examples of different Scaling and Rotation parameters definitions

● Scaling values – 100% - 500% and no Rotation, both minimum Scaling value (red frame) and Maximum 
Scaling value (blue frame) are OK. No blank area will appear on the Mosaic channel.
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● Scaling values – 100% - 500% and Rotation, note blue frame indicates that the Seed is cut, and a blank 
area may appear on some of the Mosaic variations.

● Scaling values – 142% (as recommended by the triangle warning indication) - 500% and Rotation, both 
minimum Scaling value (red frame) and Maximum Scaling value (blue frame) are OK. No blank area will 
appear on any of the Mosaic variations.

Apply Settings to All Seeds option

After editing parameters for one of the Seed files within a Seed Set, click the Apply Settings To All Seeds button, 
to apply the same settings to all other Seed files within the same Seed Set.

Click the down arrow button, and then select all the checkboxes before clicking the Apply Settings To All seeds 
button, the Scaling, Position, Rotation and Crop (Crop according to channel proportions) values will be applied to 
all other Seed Files within the Seed Set.

Click the down arrow button, and then deselect any checkbox before clicking the Apply Settings To All seeds 
button, to keep this parameter untouched on the other Seed files within the same Seed Set.

Shuffle Spot Colors

To Shuffle Spot Colors

1. The Shuffle Colors option is available for Seed files that are defined with Spot colors.
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For a Seed file defined with Spot colors, it is possible to do any of the following:

● Shuffle between the Spot colors.

● Replace Spot colors with a predefined set of different Spot colors.

● Replace up to 12 Spot colors with a user defined set of Spot colors.

To shuffle colors, do the following:

a. Select the Shuffle Spot Colors check box and click Edit.

If you select the Shuffle Spot Colors checkbox and the Seed File does not contain a Spot Color, an 
error message appears after you click Edit.

b. In the Shuffle Spot Colors window that appears, HP Mosaic identifies the document’s Spot colors.

Figure 3-13  Shuffle Spot Colors window

c. To shuffle a few of the of the file’s Spot colors, select the check boxes next to the Spot color names. 
Other Spot colors will remain untouched.

d. To shuffle all of the file’s Spot colors, select the Select All check box.
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e. Select one of the following radio buttons:

● Shuffle selected colors – Shuffle selected colors among themselves.

● Replace with set colors – Replace the selected colors with a different set. Click the dropdown 
arrow icon  to see the list of the predefined sets and select different sets to shuffle.

f. For each selected predefined set, you can do one of the following:

● Use it as is.

● Edit one or more of its colors by clicking the Edit icon .

g. To create a new set of up to 12 Spot colors, click the Plus icon .

h. In the Custom Set window that appears after clicking the Edit or Plus icon, you can edit a Spot color 
set.

Figure 3-14  Custom Set window after clicking the Edit button
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Figure 3-15  Custom Set window after clicking the + button

2. On the Title field, type a meaningful name for the color set.

3. To edit a Spot color, click its colored square.

Figure 3-16  On Edit Colors Set

Figure 3-17  On Create New Colors Set
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4. In the window that appears, select the required color using the sliders or type in the Red Green and Blue 
values for the color patch.

You can also click in the colored square to choose a color, and then fine-tune the colors by correcting the 
RGB values.

5. When defining a new Set, if 2 colors are defined, such as color1 and color6 in the example below, then the 
HP Mosaic application automatically fills the colors between them (colors 2, 3, 4, 5) with different hue 
values from 1 to 6.

You can then check few of these 6 colors or all of them to be used in the new Color Set.

Note that the name of the color can be edited. Type a new name for any of the colors if needed.
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6. Click Save to save the changes done to the color set. Note that the new color set displays on the Shuffle 
Spot Colors window.

To limit the number of color combinations for the Shuffling

When more than only few Spot Colors are selected for Shuffling, the number of color combinations can be big, 
and can results in low performance when composing the output file.

To significantly improve the performance, when selecting few Spot Colors, Designer automatically calculates the 
possible color combinations, and then offer to limit the color combination to produce optimal output file.

1. On the Colors Dialog, select the Spot Colors for the shuffling. On the below example, 6 colors were selected.

Note that Designer automatically calculates the possible color combinations (720) for the selected colors 
and suggests another number of combinations for optimal performance (100).
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2. Select the checkbox to limit the number of color combinations. You can leave the suggested number or 
type another number.

3. Click OK to confirm the Shuffle Spot Colors changes.

4. Click OK to close the HP Mosaic window and then click OK to close the Settings window.

5. Click OK to close the Image Channel window. The definition of the HP Mosaic Channel is completed.

6. To Preview the job, select the Preview checkbox from the Preview panel, and then save your job.

The next chapter provides further details and recommendations for creating Seed files and defining their 
HP Mosaic parameters.

To learn how to create the output files from Designer, see Creating an output file or HPD template file 
on page 33.
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4 Seed file design recommendations

The following are recommendations to consider when defining Seed files to use in HP Mosaic jobs.

Seed file recommendations
File type

● Seed files are Vector PDF

● Any application that can produce Vector PDF output, e.g. Illustrator, can create Seed files

File size and weight

● Seed files must be square (equal height and width)

● Seed file size can be up to 3.0 MB. The smaller the file (in MB), the faster the create output file process is for 
creating the HP Mosaic variations.

● For multiple use elements, use tools such as the Illustrator Stamp option to help minimize the file weight

Mode

● The color mode should be CMYK (not RGB) and can include Spot Colors if required

NOTE: The Shuffle Spot Colors option is enabled only for Seed files that are defined with Spot colors.

How to design the Seed files

● Use vibrant, contrasting colors

● To enable scaling up while preserving the Seed file design, use small design elements and thin elements, 
e.g. add frames to elements

● Use chaotic patterns and “untidy” design, i.e. non-linear designs and not like a checkerboard

Optimize Seed file size in MB without reducing graphic complexity

● Reduce the vector points and if using Illustrator, use Illustrator’s Simplify command (Object > Path > 
Simplify)

● Remove unneeded data and if using Illustrator, remove hidden elements in the PDF by selecting File > Save 
as PDF, and then unchecking Preserve Illustrator Editing Capabilities

● Manually combine vector elements and diminish the vector points in the document with Illustrator’s 
Pathfinder (Window > Pathfinder)

● If applicable, knock-out overlapping element’s using Pathfinder’s Merge or Trim tools

● The pattern must be vector

● The Seed file should be saved as Vector PDF
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Preview for Proofing

● Before creating the final PDF output file or HPD Template file, use HP SmartStream Designer’s Preview 
option to review the output

NOTE: It is recommended to define only one Seed per Seed Set for the purpose of Preview and review, 
and then combine the individual Seeds later into a single Seed Set.

● Preview for about 10–20 records for each Seed to make sure that the enlargement percentage maintains 
the look and feel of the design

HP Mosaic Scale and Rotate recommendations

Scale

The decision of how much to scale depends on the individual Seed file.

1. Example 1: The look and feel of a Seed file can be lost when large scaling is used. The nature of the Seed 
can be lost as in the results in the following figure. The 600% and 800% scale results lose the effect of the 
Seed file. The decision of the graphic designer in this case, based on Preview trials, might be to scale up to 
4 (400%) times larger and no more.

Figure 4-1  Scale — Example 1

2. Example 2: Text in the Seed file is a consideration for scaling. Large scaling can result in not being able to 
see the characters or words in each of the output files.

Figure 4-2  Scale — Example 2
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3. Example 3: Seed files that include thin lines (framing) enable larger scaling options while maintaining the 
Seed’s primary characteristics. For example, in the following figure, review the results for 200%, 400%, and 
800% scaling.

The graphic designer in this case might decide, based on Preview trials, to scale up to 8 (800%) times 
larger.

Figure 4-3  Scale — Example 3

Rotate

The default rotation is for Free Rotation. However, some Seed file content might lose its context under rotation, 
e.g. written text. Adjustments to the Rotate setting can accommodate such content.

Preview tests can help determine when not to rotate or when to rotate in step increments of 90°, 45°, etc. This is 
a Seed design related decision and varies on a case-by-case basis. In the second example in the preceding 
section, no rotation was used to maintain the text orientation in the graphic(s).
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Creating a Seed file from a JPG image
The Seed file is a Vector PDF. In order to create a Seed file from a JPG image, the JPG must be vectorized (traced).

Follow these steps to trace a JPG image in Illustrator, and then convert it to an HP Mosaic seed file.

1. Create a square JPG file.

Figure 4-4  Square JPG example

2. Open the JPG file with Illustrator, click Select, and then select All.

3. Click the arrow next to Image Trace, and then select High Fidelity Photo from the Tracing Presets.

Figure 4-5  Image Trace - High Fidelity Photo
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4. Click Expand.

Figure 4-6  Expand button

Illustrator creates a vector image of the JPG graphic.

Figure 4-7  Vector image example

5. Open the File menu, and then click Save As.

6. Provide a File name, select Adobe PDF as the file type, and then click Save.

NOTE: Make sure that the Seed file size (in MB) does not exceed the recommended size. Refer to 
recommendations on how to Optimize Seed file size in MB in Seed file recommendations on page 23.

7. Use this new vector image as the Seed file to produce HP Mosaic output files.

Figure 4-8  HP Mosaic output examples
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5 Seed files Q&A

1. Why would I have 2 Seed sets?

If, as an example, you want to create 50,000 random images and the database field selected for the 
HP Mosaic channel is a counter (1,2,3...50,000). The first 25,000 to be created from two seed files and the 
other 25,000 from a third seed file. You can define two Seed sets. The first two Seeds are defined in one 
set, and then the third Seed is defined in the second Seed set.

Another case for having more than one Seed Set is if you want to change Seed parameters after production 
has already started. If you have more than one Seed Set, you can change the Seed parameters for future 
copies without impacting copies that were already processed should you need to reproduce them.

2. What if my numeric data includes repeated values?

With the Template parameters unchanged and the Seed settings unchanged, the same database value 
defines the same image, that is, the same Mosaic variation.

3. How to define an HPD for Rich PDF or for Fast PDF

When creating the HPD template file, in the HP SmartStream Designer for InDesign Pack Job window, mark 
it for the PDF Fast workflow by selecting the Include Fast Template option.

When creating the HPD template file, in HP SmartStream Designer for Illustrator it is always HPD Fast, with 
no option to change it.

To also include the Seed files in the HPD template file, also select the Include variable assets option in the 
Pack Job window. See Creating an output file or HPD template file on page 33.

4. What do I do to match the leading color of Seed files to another image channel’s colors?

In the following example, there are two HP Mosaic channels. The two channels have exactly the same 
settings, parameters, and the same database field is selected for both channels. The only difference is the 
Seed files:

– Channel 1: Includes 3 Seed files with multiple colors and elements. The leading colors are green, 
black, and red.

– Channel 2: Includes 3 Seed files of solid colors in the same order of green, black, and red.

With the same Seed settings and database field, the same selections and calculations are made for both of 
the channels for every record.

For example, for a specific record, if the “greenish” Seed is selected for Channel 1, the solid green is 
selected for Channel 2.
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Figure 5-1  Example: Matching colors across HP Mosaic channels

30 Chapter 5   Seed files Q&A ENWW



5. If the HP Mosaic channel is a simple rectangle, how can I get it to selectively appear on parts of my design?

You can design elements that should appear above the HP Mosaic channel in different InDesign or 
Illustrator layers. See the example job below, with Illustrator layers. The same database record is 
previewed.

Figure 5-2  Preview option on, all layers are active

Figure 5-3  Preview option on, only HP Mosaic layer is active
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6 Creating an output file or HPD template file

The next step after complete editing the HP Mosaic channel and the InDesign or Illustrator file is saved, is to 
create an output file. For jobs with small database files with up to few hundred records, PDF can be created 
directly from HP SmartStream Designer.

For large VDP jobs, usually larger than few hundred records, it is recommended to create an HPD file, and then to 
compose (create the PDF output file) and optionally impose on the Composer or on the DFE or on the HP PrintOS 
Composer.

Creating an output PDF file
1. From the HP SmartStream Designer menu, select Create Job to create an output file.

Note that you can also use the Create Job button to produce the output file:

Figure 6-1  Create Job button on Designer for InDesign

Figure 6-2  Create Job button on Designer for Illustrator
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Figure 6-3  Create Job window in Designer for InDesign
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Figure 6-4  Create Job window in Designer for Illustrator

2. Change the name for the job, if required.

3. Only on Designer for InDesign: From the Format dropdown list, select PDF/VT. Select File and select the 
destination folder for output PDF file.

4. Set the Records Range to create a PDF with a portion of the database records.

5. Adjust other settings as needed.

6. Click Preflight to check that there are no errors with the file.

7. Click Create.

Creating an Output HPD template file
1. From the HP SmartStream Designer menu, select Pack and Submit to create an output HPD file.

Note that use can also use the Pack and Submit button to produce the HPD output file.

Figure 6-5  Pack and Submit button on Designer for InDesign

Figure 6-6  Pack and Submit button on Designer for Illustrator
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2. The Pack and Submit window opens. From the Destination dropdown list select File.

Figure 6-7  Pack and Submit button on Designer for InDesign

Figure 6-8  Pack and Submit button on Designer for Illustrator

3. The HP Mosaic Seed Files are automatically included in the HPD.

● Include variable assets: If there are more Image Channels defined in the job, select this option to 
include their variable assets from the Assets folder in the HPD file.

If the other variable assets files are not included, the location of the files must be defined manually in 
the DFE or in the Composer, and then the files should be copied to the designated location.

● Include Fast Template (in HP SmartStream Designer for InDesign):
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– In SmartStream Designer for InDesign:

○ When this option is selected, the resultant HPD is HPD Fast.

○ When this option is not selected, the resultant HPD is HPD Rich.

NOTE: In SmartStream Designer for Illustrator, the HPD file is always HPD Fast.

– HPD Rich:

○ Is supported with HP SmartStream Composer Server and HP PrintOS Composer.

○ Can include any graphic design attribute for the variable data.

– HPD Fast:

○ ○ Is supported by all the Composer products and by the Production Pro DFE.

○ Is processed in a shorter time than HPD Rich but is limited in the graphic design of the 
variable data.

○ An automatic preflight check generates a popup warning message if any design attribute 
that is not supported with HPD Fast is used. The warning message notes in which 
Personalization channel it exists.

– An HPD file created for HP Mosaic jobs can typically be HPD Fast and gain the faster 
performance advantage of this format since the HP Mosaic channels are normally a plain 
rectangle.

4. Click Pack.

The HPD file is created and can be imported to the Composer or to the DFE.
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Packing and Submitting the HPD file directly to Composer
This feature is available only on Designer for Illustrator.

Note that for submitting the HPD file directly to the Composer, the Composer should be defined first on the 
SmartStream Designer Preferences window.

1. From the HP SmartStream Designer menu, select Pack and Submit.

2. From the Destination drop-down list, select the required Composer.

Figure 6-9  Pack and Submit window in Designer for Illustrator

3. Select the preferred option for the variable Images.

4. Click Submit.

The HPD file is sent directly to the Composer and the Selected Composer is opened where you need to 
continue submitting your job.

Packing and Submitting the HPD file directly to the HP PrintOS 
Composer

This feature is available on both Designer for Illustrator and Designer for InDesign.

Note that for submitting the HPD file directly to the HP PrintOS Composer, you need to have an account in HP 
PrintOS.

1. From the HP SmartStream Designer menu, select Pack and Submit.
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2. On the Pack and Submit window, select HP PrintOS Composer from the Destination drop-down list.

Figure 6-10  Pack and Submit window in Designer for InDesign

Figure 6-11  Pack and Submit window in Designer for Illustrator

3. Select any other required parameters on the Pack and Submit window.

4. Click Submit.

5. On the HP PrintOS Login window, type in your HP PrintOS user name and password, and then click OK. The 
file is submitted directly to HP PrintOS Composer.

6. When the file is successfully uploaded to the HP PrintOS Composer, your job is displayed where you should 
continue composing it.
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A Service and support

To obtain service, please contact the customer care center within your country/region:

Europe:  

  Belgium: +32 (0)2 626 4803

  France: +33 (0)1 57 32 41 07

  Germany: +49 (0)69 38 07 89 193

  Ireland: +353 (0)1 656 9760

  Italy: +39 02 69430637

  Luxembourg: +352 (0)24 87 13 98

  Netherlands: +31 (0)20 547 6870

  Spain: +34 9 12757781

  UK: +44 (0)84 5604 7435

APJ:  

  Japan: +81 (0)1 2085 5536

  Singapore: +65 9891 1753

Distribution Channels (DC): +31 (0)20 654 5543

North America: 1-800-204-6344

Israel: +972 (0)8 938 1818

North America and 
Latin America

International Israel APJ

HP

Indigo Division

5555 Windward Parkway

Alpharetta, GA 30004

USA

HP

Indigo Division

Startbaan 16

1187XR Amstelveen

The Netherlands

HP

Indigo Division

Kiryat Weizmann

P.O. Box 150

Rehovot 76101

Israel

HP

Asia Pacific Pte Ltd

No.3 Tuas Link 4 #02-01

Singapore 637016
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Printing instructions
NOTE: To ensure a high quality print, use the CA494-25890 Rev02_print.pdf version of this document.

COVER

Paper weight 250 g

Page size 8.27 x 11.00 in (21 x 27.94 cm)

Printing HP Indigo digital press

Simplex/duplex Front cover - duplex

Rear cover - simplex

Color Full color - high resolution

Coating Lamination - shiny front and rear covers

INSIDE PAGES

Paper weight 80 g

Page size 8.27 x 11.00 in (21 x 27.94 cm)

Printing HP Indigo digital press

Simplex/duplex Duplex

Color Full color - high resolution

Coating None

FINISHING

Stitch 2 saddle stitch on left side
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